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1. General Information

Connect+ is an enterprise management software designed to monitor your store or region’s performance in real-time.

Currently, Connect+ supports the following Copeland Controllers: E2, Site Supervisor, and Dixell.

This guide provides a step-by-step guide for Store Managers or Monitoring Technicians on how to use Connect+ to monitor
your stores or regions. The following topics are included in this user guide:

How to use an Advisory Map to locate your problematic sites

How to locate sites that are not sending alarms

How to diagnose advisories

How to review Live Advisories from Controllers

How to monitor stores in real time and compare store/device performance

How to search a Site, a Controller, or a Device in your enterprise

Review Enterprise Summary including Stores, Controllers and Devices information
How to export store data

1.1 Terminology

Advisory: Alarm/Notice generated from Controller, or notification from Connect+.
Activity: A job that users conduct to access controllers.

GS Screen: Graphical Status Screen. For example, Floor Plans or Summary Screens for real-time store monitoring.

Nav Frame: A tree frame located on the left side of the screen.
List Power Builder: Tool for creating Watch/Graph Points list.
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2. Logging into Connect+

2.1 LogIn 2.2 Navigate Connect+

Before logging into Connect+, contact your Manager or IT Once logged in, you will see that Connect+ Ul is designed
with four areas:

Department to obtain your Connect+ Login credentials.

COPELAND

PROACT’

Upon your first login to Connect+, you will be asked to « Area 1 contains main toolbar icons for access to the

change your password. Please enter the generic password Enterprise Level Information, such as Alarms, Sites
you received as your Current Password. Select a password without Alarm Connection, Store/Device Summary,
with no less than 8 characters. Schedule Jobs, Global Search, and more.

- Area 2 is the Navigation Tree, which is set by your
Administrator to reflect your Enterprise Hierarchy. The
navigation tree starts from the Directory level, which
reflects the Region or Banner you belong to, then your
Sites that reflect your Stores. Under each store, you can
review the Controllers installed, down to the Devices the

COPELAND

Reset Your Password

uuuuuuuuuu

When you right-click on each level in the Navigation Tree,
you will see the Right-Click Menu, which is provided

to review information or perform activities to access
controllers.

+ Area 3is the Context Menu, which is associated with
your Navigation Tree level. The Context Menu is same as
the Tree Right-Click Menu.

« Area 4 is the major Review area. When you click the
Enterprise Toolbar, Navigation Tree,

COPELAND

—
"""""" Right Click-Menu, or Context Menu, the information
== or Controller Activity progress/result is displayed in this
N area.
PROACT 2.2.1 Connect+ Enterprise Toolbar
Navigation
If you have forgotten your Password or Login ID, click S e tsaroge
Forget Password or Forgot Login ID. You must have a
valid email in your user profile with Connect+ in order to larm conwith

Alarm Number

receive the temporary password or Login ID.

‘ T
Returnto |
Homepage  Header Search bar for Directories, Sites,

Control Systems, Users,
ervice Providers, and mor
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View Advisories upon clicking.

Homepage

Enterprise Summary

Header Menu

Language Setting

Global Search -
or Points.

2.2.2 Store Hierarchy by Navigation Tree

From the Navigation Tree of the Connect+ landing page
interface, a Store Hierarchy is reflected by the Tree listed
with the concept of Directory, Site, Control System, Unit,
Application Type, Application, and Point.

Refresh Filter Clear
Nav Tree Points Check-box

Refresh  2cne Ponts v

&_ Watch or

Graph Points
Site Direclorkes

2
E] [

o i vsG1 Singapece

E

=F ¥+

8 B Roo-300 11 E2 Unitan

Navigation Tree

Directory

Directory is a region or a banner of a customer. Connect+
offers a sub directory under the parent directory to reflect
the user’'s own organization structure.

Sites

Sites are stores in the customer’s organization. One site
belongs to only one Directory.

Control System

A control system is a set of controllers within one localized
store. A typical grocery store control system would contain
building management controllers and refrigeration
controllers.

026-1022 R2 Connect+ Basic User Guide

Check Region, Site, Controller, and Device Information.

Access to List Power Builder and Schedule Manager to:

- Create preferred Device Attribute List to monitor

- Schedule different activities to execute jobs on Controllers
Allows users to change the Language Setting.

Unit

Users will be directed to their own Connect+ Homepage once the preference is set.

Count indicates the Total Number of Active Alarms in the Past 24 Hours. Users will be directed to

Count indicates the Total Number of Sites without Connection in the Past 24 Hours. Users will be
directed to Connection Verification Report upon clicking.

Offers Global Search for your Site Homepage and global search for any Sites, Controllers, Devices,

A unitis an individual controller at a site belonging to a
control system. There may be more than one unitin each
control system. One controller would be configured as
the gateway in the control system to communicate with

Connect+.

Application Type

An application type is the type of application that has been
set up inside a unit (controller). There are many types of
applications programmed into the controller. All application
types contain applications that belong to the same

application type.

Application types range from physical applications that
connect to a real device, such as air handlers, standard
circuits, sensor control, analog and digital combiners or
logical applications such as zones, power monitoring,
global data, time and dates, time schedules, user access

and more.

See below figure for REF Controller Application Types and
Building Controller Application Types examples:

= i 154 Arlanes
=EF -]

# [3 Condensers

# [[ Digical Combiners
3 [3 Enhanced Suction
# [3 Flexible Combiner
4 [J General Sewup

# [3 Global Data

# [[ Rack Simulator

# [ Bx-400 1: HVACATS

3 [3 Physical Pulse Oupe

& [ Remete Disloue Serup
4 [ Sensor Control AV
8 [ Sensor Control DV
¢ [3 Time and Date
8 [3 User Access Levels
# [ Ri-200 3: PROTO A/B

= & E2

2 B Bx-400 1: HVAC/LTS
4 [3 Air Handlers [AHUs)
4 [3 Alerm/advisory Setup
# [4 Anzlog Combiners
4 [3 Digital Combiners
[ Flexible Combiner
4 [3 Generzl Setup
9 [ Glabal Dat
# [3 Heav/Cool Control
4 [ HVAC Zones
4 [d Lighting Control
4 [3 Legging Groups
3 [3 Physical A1
4 [3 Physical a0
+ [ Physical DI
# [g Physical DO
3 [3 Power Monitoring
4 [ Remote Dialout Setup
# [3 Sensor Control AV
4 [§ Sensor Control DV
4 [3 Time and Date
9 [3 Time Schedules

4 [3 User Aczess Levals
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Application Instance

An application instance shows the application (if available)
that has been programmed inside a controller to access a
physical device or define the controller setting. Through
the application instance, users can either access a physical
device's data points, such as an ice cream case controller,
or access applications that are programmed to configure
the controller, such as user access or alarm settings.

Point

Application points are attributes that have been
programmed inside a controller application. Access to
application points allows the user to view details about
the points, graph points, retrieve logs, and make changes.
In Connect+, there are three categories of points: Input,
Output, and Parameters.

Aninput point can be associated with an output point of the
same data type, and vice versa (for example, digital outputs
to digital inputs, analog inputs to analog outputs). An input
point cannot be associated to another input point, likewise,
an output point cannot be hooked to another output point.

+ Active Points is the default each time the user opens
the browser and will show all configured points in the
controller.

+ Active with Logs shows active points that have a
controller log available.

« Points with Logs shows points that have a controller log
available.

+ All Points shows all possible points for an application
instance, whether a point is configured or not. An icon
appears next to the point if the pointhas a log.

COPELAND

o0

D 1n
Points D e
with Logs (SRS T,

—— All Points
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2.3 Complete My Profile and Set
Preferences

2.3.1 Profile & Preference

To check your User Info to complete and set preferences,
click the icon next to your name and click User Info:

Set As Home Page
User Info
My Home Page

Logout

Complete Email

If you currently do not have an email, you need to enter a
valid email address. Without email information:

You cannot receive emails from Connect+ when you
go through the Forget Password or Forget Login ID
process.

You cannot receive the verification code during login
if your organization decides to activate Multifactor
Authentication.

Updated Password

If your organization has activated the Reset Password
Every 90 Days option, you will be reminded to update your
password when your current password is expiring within 14
days.

Setting Preferences

In my User Information Preferences and Units section,
you can set your Connect+ Navigation Preferences and
Engineering Units.

«  Show GS Screen Edit Tool: This allows the GS Screen
menu visible on the right-click tree menu. Default is not
enabled.

- Enable Home Page: This allows you to set your
Connect+ Homepage. Default is not enabled.

©2024 Copeland LP.



+ Hide Nav Frame: This allows you to hide the navigation
tree. Default is not hiding.

« Enable GS Screen Auto Logout: This allows you to be
automatically logged off when the GS Screen page is
inactive for 30 minutes.

 Engineering Units: English/Metric/Global units. Default
is English units.

You can set your language preference directory from the
Enterprise Toolbar. Currently, you can only choose from
English or Spanish.

2.3.2 Set Connect+ Homepage

When you enable the Homepage Setting, you will see the
Set as Homepage menu option when you click the User
Profile icon next to your name. Currently, Connect+ allows
you to set Graphical Screens as your Connect+ homepage.

It is recommended to set the Enterprise Advisory Map as
your Connect+ Homepage for overall optimal Enterprise
performance.

If the Advisory Map has been enabled for your organization,
you can access Advisory Map at the Directory Level. Click
your organization’s parent directory, or access from the
right-click menu > Advisory Map.

i =
Map  Satelite

When you are on the Advisory Map page, you will see all
Sites in different alarming states. The Advisory Map allows
you to have a quick glance on your Sites’ status in the past
24 hours. Click Set As Home Page from the user profile
icon next to your name.

026-1022 R2 Connect+ Basic User Guide

You can also set other Graphical Screens as your
Homepage. As introduced in the What is Connect+ session,
Graphical Screens are Floor Plans or Summary Screens

are for real-time store monitoring. You can access these
Graphical Screens from the Navigation Tree, when you
right-click any level, you will see a list of System Summary
Screens indicated with a blue icon, and customized
graphical screens indicated with an orange icon.

- @ Cemo
+ iy 00211

+ 4 0215 Xian

154 Atlanta

[ Refrigeration Summary

[ Building Summary

54 Other Summary

Demo Refrigeration Summary

o

Y E2 Store Summary

FEY Summary

Open any Graphical Screen at any Tree Level, click User
Profile > Set As Homepage, and the Graphical Screen will
be set as your Connect+ Homepage.

NOTE: You can also set the Homepage for each Site. This will
be covered in more detail in the Graphical Screen session.

©2024 Copeland LP.



2.4 Manage Your Own List

A list contains points that you are interested in. You have flexibilities to choose your preferred points from different stores and
controllers for the same Application Type to compare store performance. Or you can also select a number of points for a single
store or controller to monitor.

You can also create your own list using the List Power Builder. Access List Power Builder from the Header Menu > List Power
Builder > Add New.

Criteria
Watch Points Lists Use * (asterisk) for wildzard at the start or end of a match string.
Select a list to load or type in @ new List Name to create a new List, | Separate multiple matches in & single field with commas. additional
Help
M Directory
# Site
) P JhControl Systzm
Load List wesglect Bt v [=p
List Name 3 apslication Type
[ Application
Instance
% poim cate T
i CEERESY . ive wilogs v
| Point
Add To List
List Size: 0
[[me.Joic [Site Jcs Tunic [2pp Type [&pp Inst [Category [Point |

1 | | | | | | il |

You can create a new list by entering your criteria under the Criteria section on the right as shown in the figure below. For
example, if you want to get all the case controller temperature points, you can leave the Directory/Site/Control System/ Unit
blank and enter the case controller Application Type name. If there are multiple names, separate them by commas. Then enter
the Point Name as the same name from your tree. Click Add To List and the list of points are retrieved as shown below.

You can also filter points and remove filtered items to further refine your list.

Watch Points Lists Snthlat k) for wildeard at the start or end of a match string. Separate multiph
Select 2 list to load or type in  new List Name to create a new List. se * (asterisk) for wildeard ot the start or end of a match string. Separate multiple

matches in & single field with commas, acditonsl Help

[

- s
Lose List et s A & Control System
List Name AU List 042520200 B une

[ aoplication Type  FARUS

[ 2pplication Instance

£ poin Category ¥ | [Active Pints v

|~ pans

Save as new List
Add To List
List Size: 10000 | Remove Al s
[Tl 5 = = T e ey ot
v

LAty Service |Site 2 S5 BleHVAC/Lite  |AHULarge [AHU 1 Params |A FreezeStat input is toe lowl
|2 Service |Site 2 S5 BXe:HVAC/Ltz [AHULarge [AHU 1 Params |A FreezeStat input is toe lowl--Category
“[z Sevice |52 5 EXeivAC/Lte [AHULae [ARUL parame - Freszester ngus s toa ovi--Disp 2y Meseaze
7[5 | mefngarsuon servies |se 2 s BrevAC/e |aHuae  [ARUL params = Fraszesias mpet 2 130 lowi—Haner Alarm
“s - Service [sme 2 5 SxevAC/Lte [aHULas  [ARUL param e ——
76 | mefngertion Servies |si= 2 5 BxevAC/te |aHUae  [AHUL params 2 Frezzzsrat mput s too low2
77 g Service [sr= 2 5 e ruee  [ARUL params  Freszesiat mput = 130 lowa-—Caregory
Zls | mefngertion servies |si= 2 ss BxevAC/te |aHUage [AHUL params = Freszesiat mput i 190 lowa--Display Message
“Is - Service [5r= 2 5 BrvAC/re |FHUee [ARUL P = Freszestat mpot = 130 lowa—Hanor Alzrm
10 Refrigerstion Servics |Sit= 2 S5 EXeiHVAC/Lts | HULarge [aru Params 2 Fresseseat input is too low2-Repest Rate
Showing 1- 10 of 10000 Page Size: (10 ¥ Nexth

Enter a unique name for your list. Save As A New List button will display when you have a valid list name. Click Save, and you
can use this point list later to watch your store.

Watch Or Graph Points

Display Log Graph Retrieve Logs + Graph Retrieve Logs Retrieve Logs + Export m

NOTE: Only the first 15 paints will be used on the graph.

#| 1. HVAC/LTS"/&ir Handlers (AHUs)/1-MAIN AHU/Outputs/SPACE TEMP OUT

#| 2. HVAC/LTS"/Air Handlers (AHUs)/SALES AREA/Outputs/SPACE TEMP OUT

| 3. HVAC/LTS"/ &ir Handlers (AHUs)/RTU-1 BAKERY,Qutputs/SPACE TEMP OUT

#| 4, HVAC/LTS"/Air Handlers (AHUs)/RTU-2A PRODUCE/Outputs/SPACE TEMP OUT
#| 5. HVAC/LTS"/Air Handlers (AHUs)/RTU-2B PRODUCE/Outputs/SPACE TEMP OUT
#| 6. HVAC/LTS"/Air Handlers (AHUs)/RTU-3 KITCHEN/Outputs/SPACE TEMP OUT
#| 7. HVAC/LTS"/Air Handlers (AHUs)/RTU-4 CONF RM/Outputs/SPACE TEMP OUT
#| 8. HVAC/2ir Handlers (&HUs)/IT STORAGE/Outputs/SPACE TEMP OUT

| 9. HVAC/Air Handlers (AHUs)/RECEPTION AREA/Outputs/SPACE TEMP OUT

#| 10. HVAC/Air Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

#| 11 HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TEMP OUT
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3. Advisory Map, Advisory View, and Live Advisories

Advisory is defined as the notifications or alarms generated
from Controllers to report store crisis. Currently Connect+
supports receiving Advisories directly from Copeland
Controllers E2, Site Supervisor, and Dixell. Connect+ can
also receive Advisories from Danfoss if a Danfoss Site is
sending alarms to the ProAct Alarm Service.

Advisory Type by Controller:

- E2: Alarm, Device Failure, Notice

« Site Supervisor: Critical, Non-Critical, Notice
+ Dixell: NA

+ Danfoss: Severe, Critical, Normal, Log Only

Advisory State:

Each advisory in Connect+ have two states: Active or
Return to Normal.

An advisory remains active until the condition to generate
the advisory returns to normal.

Active

An Advisory occurs when a controller generates the

alarm based on the alarm parameter configured. Alarm
parameters involved in advisory occurrence are High/Low
limit and Alarm Delay.

For example, technicians can configure Case Controller
Temperature Alarm Hi/Low limits for the normal temperature
range. And a 10-minute Alarm Delay. Once the temperature
is outside of the setpoint, either above Hi Limit or under

the Low Limit, the controller will wait until the Alarm Delay
passes and then generate an alarm.

The alarm will remain Active from the Advisory Occurrence
Time until the point value returns to normal.

Return to Normal

An Advisory will Return to Normal once the point value

is back inside the normal range. There is another Alarm
Configuration that will affect the Advisory Return to Normal
time: Alarm Hysteresis. When the Alarm hysteresis is
configured, an Advisory will change to the Return to Normal
state only when the current point value is in range of (Hi
Limit - Alarm Hysteresis) and (Low Limit + Alarm Hysteresis).

026-1022 R2 Connect+ Basic User Guide

Advisory Priority:

Advisory Priority is a concept with Copeland Controllers E2
and Dixell. Connect+ provides the same concept for these
two controllers.

E2 1-99
Site Supervisor NA
Dixell 1-99

Urgency Level

Urgency Level is a Connect+ defined Advisory Property.
When you have multiple controllers across organization,
itis difficult to tell which Advisory need your immediate
attention with different Advisory definition for different
controllers.

In order to solve this problem, Connect+ defined Urgency
Levels as shown below. This allows users to have a
consistent view of Advisories Severity. Currently the
definition is default in Connect+:

Advisory Priority for E2 and Dixell

Urgency

e

Room Temp
Alarm

High

1t0 20 B T q
ase Temp an
Food Safety Prod Temp
Active  Heat Pump
21t050 Status Block
Alarm
Low 511099 HRC Alarm from
Heat Pump
Low 11099 RTN

Advisory Priority for Site Supervisor

Urgency

e

Room Temp

High

Alarm
Critical P q
Food Safety ase_‘empan
) Prod Temp
Active
Heat Pump
Non-Critical Status Block
Alarm
Low Notice
Low Any RTN
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3.1 Advisory Map

3.1.1 Access Problematic
Stores via Advisory Map

If your organization has enabled
Advisory Maps, when you click the
parent directory in the Navigation Tree,
you will see an Advisory Map as shown
below with the Advisory Urgency
legends. You can set this page as your
Connect+ Homepage for Enterprise
View.

[TFss)

lpiego

Las Yegas

Google

NAY.

DAKOTA

United Stat
ADO

Mexico TAMAULIPAS

ARIT

aaaaa

Site Severity Level the below legends:

Past 24 hours

further details.

Sites in the Advisory Map are indicated with an Alarm Urgency Level in the past
24 hours. You can click on any problematic Sites to further investigate based on

Red indicates Sites with Food Safety Alarms/High Alarms.
Orange indicates Sites with Medium Urgency Alarms.

Yellow Indicates Sites with Low Urgency Alarms.

Green indicates Sites that does not have active Alarms.

Grey and Flashing indicates Sites without Alarm Connection.

If you know your Site Name, you can also enter the site name in the search box.
The search result will flash for 5 seconds on the Advisory Map for you to check

When you click the Site, you will see a snapshot of the Site, which includes Site Name, Site Address, and several quick links:

Map  Satellite fara - 15¢ o
Site Severity Level
T —
United States Karidas Ciy .
. = T
g » MISSOURI
Past 2¢ hours
oo
oA +
[Fowss) fiZoN -
biego Phosnix Dallas
% Bermud
Tucson W 2
AIA o0
NI Aust Jacksonvil
sonoRA o s
s New Oresns
R
oTampa
‘‘‘‘
Gulfof
Mesic The
Banama
Havana
5
Turks and
Google.  wavamr 5 e S
Coumi Washington
Map Satellite St. Louis i DELAWARE
pvna MISSOURI il ! FIReiiA
wichita mhe S E e et I - -, o el
National Forest Rehgond Wi 8 ke seven ity Level
Springfield VIRGINIA
——
» a Norfoko. aVirginia Beach [ =
Tues W
OKLAHOMA &
Oklahoma City
o
i Memphis
Norinan i
ARKANSAS +
Wimogion
SOUTH -
CAROLINA Mt pex
MISSISSIPP
Dallas cn =
sine FOrtWortho o Shevep: 8
i scksor ol .
=
TEXAS
. Talahsssee
Aust etk LOUISIANA e ° drcrsorille
Hnon e Qteans
San Antonio
e
Tampa
Goggle e G i Map datz £2020 Gooale, INEGI Terms of Vse!
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154 Atlanta - 154

Advisories
Active Return Total
o 4 4

0 3: PROTD AJB)
E2 Unitd4}

* Advizories based on |zst 24 hours

When clicking the Site Name, you
will be directed to your Site Home
Screen if configured.

When clicking Advisory View, you
will be directed to View Advisories.

When clicking Controller View,
you will be log into Controller
Terminal Mode.

©2024 Copeland LP.




The Advisory Map View allows you to review your stores and locate problem sites as quickly as possible. The quick links for
each site provide access to locate advisory information and take further actions. From Advisory View, you can review Alarm
Details with Log Graphs. From Controller View, you can access Terminal Mode if you need to change settings to clear the

alarm.

3.2.1 Your Advisory Map Setting

Map Satellite Nosthweste s Q’
" Passog Greenland
- - Iceland i e
Finland - )
ooy 7 Site Saverity Level
Canada Hislnex Hay Advisory Map View Setting Food Safet
T
eE @ Show Legend
w Legen
AT i .
5 P Belarus. [No Alarm Connection i §
Al Sites retand iy o Alarm Connecrion
Germany
Only Sices With Adviseries . 3 Past 24 hours
- Kazakhstan
S ur o ¢ W Sites with Food Safety Advisories
= t W > : * 9 Sites With High Severity Advisories . A +
i N o ehekistan | i
V| AUnited SToteay Sites With Medium Saverity Advisories el Greece Turkey Turkmenistan —
* 101 %
s b - Sites With Low Severity Advisories Tuniel e ; Afghanistan
3 ra
P" it ‘r" % Y Moroceo 4 Iran e
R Sites With No Alarm Connection Pakist @)
2an Al ]
Qulf o e Libys Egypt )
Wi Western
Mexica e m n S Saudi Arabia o
o Oman
Mauritania| e
Gustemals : e Chad Sudan Yemen
Nicaragus Gy = I of Ades Arabian Sea
Nigeria
Venezusla Ethiopia
Garara Gheans South Sudan achi
Colombia | " Sunname : Somalia
AR : !
- 3 / Kenya
——————————————— Ecusdor. Cabon onr
st 8
' o8 Tanzanla
: Brazil £
777777777 i Pery - :
G I 5 & Angola Ty it
oogle M Maz dats £2020 Googls, INEGL Tarms of Use

1. Map or Satellite View: Allows
toggling between Google
Maps view or Satellite view.
With the satellite view, you
can view a real image of your
stores, s ometimes including
roof top unit views.

Map

Setting: If you have many
stores, your Advisory Map
might appear crowded. You
can filter your stores in the
Advisory Map to have focused
views:

Once you click OK, your
Advisory Map Preference is
saved. When you view the
Directory Advisory Map again,
it will only show the sites with
your set preferences.
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Advisory Map View Setting

¥ Show Legend
® 4l Sites

Only Sites With Advisories

° Sites with Food Safery Advisories

@ Sites With High Severity Advizories
Sites With Medium Severity Adviseries
Sites With Low Severity Advisories

’ Sites With No Alarm Connectien
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3.2 Advisory View

The Enterprise toolbar alarm icon provides a quick overview of how many total active alarms you have across your stores
in the past 24 hours. Whenever there is new alarm received by Connect+, the number will increase and flash for several

seconds.

coPELAND A’ »°Q B =

3.2.1 Advisory List View

You can access the Advisory List View when you click this toolbar. As in the Advisory Map View, the Advisory List View is
organized by Advisory Urgency Level:

Advisories View

12
1

Occurrence Date |Bast 24 Hours

v Time Perspective: | Site Time v Show|25 ¥

(ResetFilters ¥ Refresh Advisories ) Restore Default Format

Al

i sy g e Y s R e

State

Occurrence Date v

4/25/2020 8:29 AM

020 9:46 AM
020 12:05 AM
4/24/2020 10:46 PM
4/24/2020 10:46 PM
4/24/2020 10:46 PM
020 10:46 BM
020 4:46 AM
H 020 4:46 AM
4[25/2020 8:16 AM
4/24/2020 10:46 PM
4/25/2020 4:46 AM

4/24/2020 9:46 PM

Ag=

10.5h
16.2h
13.8h
21.2h
21.2h
21.2h
21.2h
21.2h
21.2h
21.2h
21.2h
21.2h
22.2h

Type
Al
Alarm
Fail
Notice
Fail
Fail
Fail
Fail
Fail
Fail
Fail
Fail
Fail

Fail

Advisory Message

Case Temp Hi Limit Exceeded
Controller Not Sending Alarms sinc...
Compressor Cycle Rate Exceeded
Controller Not Sending Alarms sinc...
Controller Not Sending Alarms sinc.
Controller Not Sending Alarms sinc.
Unknown Code: 20,001 [Controller.
Controller Not Sending Alarms sinc...
Controller Not Sending Alzrms sinc...
Controller Not Sending Alarms sinc..
Controller Not Sending Alarms sinc.
Controller Not Sending Alarms sinc.

Unknawn Code: 20,001 {Controller.

. Application Insta...

A12 SDK BEER

Rack C Suction

Source Typs  Status Point Limit

Al A
Davics

System

CB Mainta... A

System
System
System
System
System
System
System
System
System

System

Al 2
CASE TEMP 2 48.0

CYCLE RATE STA.. 240.0

Occurrence Date

Received Date

Displays the date time when the advisory was generated on the controller.
Displays the date time when the advisory received in Connect+.

Displays advisory duration:

Alarm Age If the advisory is still active, Alarm Age = Current Date time - Occurrence Date.
If the advisory is return to normal, Alarm Age = Return to Normal Date - Occurrence Date.
RTN Date Displays the date time when advisory is back to normal.
Source Displays controller, application, and property information from which the advisory was generated.
Source Type Besides controller, Connect+ will also .ger)erate 'AQyisories. Such as Contfoller Offline Alarm, Pre'dic.tive Mainte-
nance Alarm, and more. Source Type indicates if it is from Controller, Device, or Connect+ Applications.
Point Displays point from which the advisory was generated.
Limit Displa_ys the high or low l.im_it the advisory will exceeded to generate the advisory. This is usually configured by your
technician during commissioning phase on the controller.
Trip Value Displays the point value when advisory is generated.
Advisory Message griqsgtzycsoanr:r(e)ﬁzlfnation of the advisory. This is usually configured by your technician during commissioning phase
Add Comment Users can add comment of the selected advisory.
Comment Displays the latest comment user added.
Different Controllers using different Type to categorize Alarm Severity.
Type E2: Alarm, Fail & Notice for E2
Site Supervisor: Critical, Non-critical & Notice
Priorities Displays urgency level of advisories as numerical (1-99). It is configurable in Controller
026-1022 R2 Connect+ Basic User Guide 10 ©2024 Copeland LP.




3.2.2 Read Alarm Related Log Graph

From the Advisory List View, you can access Advisory Detail Information and log into the controller (if needed):

Access Point Log Graph from Advisory Message Link

From Advisory View, you can only see the alarm-related points Log Graph. The same applies to the Log Graph in Advisory
Email. You can read the multiple points Log Graph from Watch Points & Graphical Screens.

LER-El IH 4H 12H 1D 2D 4D 1w 4w

- -
From (2020-03-20 14:45:00 || & Te |2020-03-20 18:45:00 || & E

CASE TEMP 1 | 1.:38 CASE TEMP 1 1133
DEFROST Case Alarm Hi 5.00F

75

-25
15:00 15:30 16:00 16:30 17:00 17:30 18:00

i 154 Atlanta/LT3 RI FROZ FD/CASE TEMP 1 == {§j 154 Atlanta/LT3 RI FROZ FD/Case Alarm Hi (no log in controller)

On
W
S off
S na

15:00 15:30 16:00 16:30 17:00 17:30 18:00
 15¢ Atlanta/LT3 RI FROZ FD/DEFROST
T

55 Dev |

Advisory Message
case temp

Case Temp Hi Limit Excesdad

Case Temp Hi Limit Exceeded

Case Temp Low Limit Exceeded

Case Temp Hi Limit Exceeded

Case Temp Low Limit

‘Source

CASE TEMP 1
CASE TEMP 1
CASETEMP 1
CASE TEMP 1
CASE TEMP 1
CASE TEMP 1

CASE TEMP 1

.. Application Insta... Source’

A12 RI BEER

A29 SALAD BAR

LT2 RI FROZ FD

LT4 RI FROZ FD

LT2 RI FROZ FD

The information below will help you read the Log Graph:

Log Graph Range Set the time range of the data to show point log in the graph.

Alarm Status Displays advisory point and its related points value and alarm status.

Point Log Displays advisory point and its related points log in graph.

Defrost Cycle Displays defrost status in graph.

Setting You can choose time perspective, download, print, save log graph date range as default.

3.2.3 Other Quick Links
From the Advisory List View, there are other quick links to:

Access Site Home Screen from Site Link
Access Controller Summary Screen from Unit Link
Access Application Summary Screen from Application Type Link

026-1022 R2 Connect+ Basic User Guide 11
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3.2.4 Filter Advisory List View

Filter Advisory List by Urgency Level or Occurrence Time

Advisories View

becurrence Date Time Per ive: [Site Time ¥ Show (25 ¥
Past 24 Hours
Curren
Past Wesk
‘Current Month
Past Month
ctiv Custom Range

| 4[25/2020 8:29 AM . LCass Temp Hi Limit Exceeded A12 SDK BEER CASE TEMP 2 28.0
® E Active 4/25/2020 9:46 AM 163h Fail Controller Not Sending Alarms sinc_ 10 Systam Accepted
® E ave 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
® E aive 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
O F e 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepted
@ F i 4/24/2020 10:46 PM 21.3h Fail Unknown Code: 20,001 {Controller... 10 System Accepted
® F e 4/25/2020 4:45 AM 213 h Fail Contraller Not Sending Alarms sinc... 10 System Accepted
O E e 4/25/2020 4:46 AM 213 h Fail Controller Not Sending Alarms sinc_ 10 Systam Accepted
O E e 4/25/2020 8:16 AM 213 h Fail Controller Not Sending Alarms sinc__. 10 Systam Accepted
@ [F Aave 4/24/2020 10:46 PM 21.3h Fail Contraller Not Sending Alarms sinc... 10 System Accepred
@ [F Aae 4/25/2020 4:46 AM 213k Fail Contraller Not Sending Alarms sinc... 10 System Accepred
® B awe 4[24/20209:46PM  22.3h Fail Unknown Coda: 20,001 (Controller... 10 System Accepred

Filter Advisories by Filed Filter: For example, if you enter Case Temp in the Advisory Message field, all the alarms will be
filtered with Advisory Message that contains Case Temp.

Advisories View

Occurrence Date [Past 24 Hours Time Pe: ive: [GteTime V] Show (25 ¥

4/25/2020 8:29 AM 107 h i A12 SDK BEER Acceptad CASE TEMP 2

3.2.5 Customized Advisory List View
You can customize your Advisory List View by:

- Adding or removing more columns as indicated below.
- Dragging the column header to reorganize your field sequence.
« Clicking on each column header to sort the list.

Your preferences will be saved for future viewing:

Occurrence Date [Past 24 Hours Y|  Time Pe ive: [Site Time. hd Show [25_ ¥
Add Comments
Unit ID
State
ol fEmerets [#] Occurrence Date bl 1 L
® [ o 4/25/2020 8:25 AM 0.6k o | o mrers 20 AIZSDKBEER  Davice Accepted  CASE TEMP2 48.0
A
® [ sawe 4/25/20209:46 AM 163k @ @ g Hq Syst=m Accepted
mns Site
® E A 4/24/2020 10:46 PN 213 R ] p 10 Systzm Accepted
Ty
O F Ao 4/24/2020 10:46 PM 213 h Fail Controller Not Sending @ Tyee 10 Systam Accepted
V| Advi Messag,
® [F sawe 4/24/2020 10:46 PN 213 R Fail Controller Mot Sending = . 10 Systzm Accepted
7 s
® [F zawe 4/24/2020 10:46 PM 213k Fail Unknown Code: 20,00 oure 10 System Accepted
® |i| Active 4/25/2020 4:45 AM 21.3h Fail Controller Not Sending | Priaricy 10 System Accepted
® E save 4/25/2020 4:46 AM 213 h Fail Controller Not Sending (&) APPplication Instance 10 System Accepted
® [E Acie 4/25/2020 8:16 AM  21.3h Fail Controller Not Sending (4] S0Uree Trpe 10 System Accepted
® [F o 4/24/2020 10:46 PM 213 h Fail Controller Not Sending (] Stts 10 System Accepted
® [F sawe 4/25/2020 4:46 AM 213 h Fail Controller Not Sending A=y 10 System Acceptad
® B Aaie 4/24/2020 9146 PM 223k Fail Unknown Code: 20,00 Cantral System 10 System Accepted
Unit
Application Type
[¥ Point
< »
oy
Trip Value
B o
For
. ) ) 3 Urgency
: low n) indicates an advisory has returned to normal. The resul our search may contain st corvesoidng < oadier than nge.
Notes: A type fellowed by (rin) indicate advisory has returned to I, Th lts of yi rch may contain extra dat ding to dates eadier th; gt
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3.2.6 Access Advisory List View from Navigation Tree 5 B oeme
+ iy 00211
You can also access the Advisory View from all levels in Navigation Tree by ﬂ:”“”‘a"
clicking Right Click Menu > Advisories > View Advisories. j.m P
* a
This allows additional flexibility to access Advisories at a certain Site, Controller, lsf nu::f: :

Device, or a known Point.

2. ] Refrigeration Summary
] Building Summary
2.} Other Summary
® Demo Refrigeration Summary
™ E2 Store Summary

3.3 Live Advisories

™ Summary
Configure 3
If your organization will not enable Advisory Receiving in Connect+, your e ’
advisories can be viewed in Live Advisories. Connect+ will access the Control R g
Advisori View Advisories

System or Controller to get Live Advisories on the Controller when you click Right
Click Menu > Advisories > View Live Advisories from the Navigation Tree at the
Control System or controller level.

A Forward Advisories
A\ Connection Verification Report
&

Summar]

Sl Configure Advisory Purge
Food Qu L Configure Advisory Snooze

‘._fx Configure TAC Advisory

Energy
CB Maintenance I
Refrigerant I -
Live Advisories View
Occurrence Dare [All v show 25w
C ResetFilters 3 Refresh Advisories O Restore Default Format
Occurrence Date Type Unit Source Pric... Status Advisory Message Advisory Limit Property Value
Al v Al -
04/25/2020 16:06:02 3: PROTO A/B  PROTO 4/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unackno Product Temp Hi Limit Excasdad 21.0 66.2
020 10:06:12 3: PROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unacknow =mp Hi Limit Exceadad 41.0 66.2
020 04:06:02 : PROTO A/B  PROTO A/B:B23E FISH CLR :PRODUCT TEMP 1 20 Unacknow Product Temp Hi Limit Excesded 41.0 66.2
04/24/2020 22:06:12 { PROTO A/B  PROTO A/B:B23E FISH CLR :PRODUCT TEMP L 20 Unacknow Product Temp Hi Limit Exceseded 41.0 66.2
04/24/2020 16:06:02 : BROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unacknow emp Hi Limit Excesded 41.0 66.2
04/24/2020 10:06:02 3: PROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unacknow =mp Hi Limit Exceadad 41.0 66.2
04/24/2020 04:06:17 PROTO A/B:B238 FISH CLR : 20 Unacknow emp Hi Limit Excesded 41.0 66.2
04/23/2020 22:05:5 PROTO A/B:B23E FISH CLR 1 20 Unacknow 'emp Hi Limit Exceeded 41.0 66.2
04/23/2020 16:06:01 { PROTO A/B  PROTO A/B:B23E FISH CLR :PRODUCT TEMP L 20 Unacknow 'emp Hi Limit Excesded 41.0 86.2
04/23/2020 10:06:18 3: PROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unacknow =mp Hi Limit Exceadad 41.0 66.2
04/23/2020 04:06:02 3: PROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP 1 20 Unacknow =mp Hi Limit Excesdad 21.0 66.2
04/22/2020 22:06:18 { PROTO A/B  PROTO A/B:B23E FISH CLR :PRODUCT TEMP L 20 Unacknow Product Temp Hi Limit Exceseded 41.0 66.2
04/22/2020 16:06:07 { PROTO A/B  PROTO A/B:B238 FISH CLR :PRODUCT TEMP L 20 Unacknowledged Product Temp Hi Limit Excesded 41.0 86.2
04/22/2020 11:33:19 Alarm RX-400 3: PROTO ... PROTO A/B:ATC MONITOR A :COMMAND OUT 15  Unacknowledged Digital Sensor Alarm OFF OFF
04/22/2020 11:33:19 Alarm RX-400 3: PROTO ... PROTO A/B:ATC MONITOR B :COMMAND OUT 15 Unacknowledged Digital Sensor Alarm OFF OFF
04/22/2020 11:27:24 Alarm (rtn)  RX-400 2: RAK LT/TC  RAK LT/TG:LT2 RI FROZ FD:CASE TEMP 1 16 Unacknowledged Case Temp Hi Limit Exceeded 10.0 13.2
04/22/2020 11:26:20 Alarm RX-400 3: PROTO A/E  PROTO 14 SVC PLTRY: CONTROL TEMP 16 Unacknowledged Comb Temp Hi Limit Excesdzd 41.0 40.0
04/93/2020 11:25:19 Alacm (m0) _B¥-400 3. PROTO A/R__DROTA A/R:Walk-in Cooler:CASE TEMP 1 16 lnacknoudadoed {==a Temn Hi Limit Fxceeded 410 334 h
Id 4 | pana1 of2s | b Bl | Disnlaving advisories 1 - 25 of §17

Displays the date time when advisory is cleared on controller.

Cleared Date
Status

Displays whether the advisory has been Acknowledged, Unacknowledged, or Muted.

As with the Advisory View, you can sort, filter, and add more columns for your review. You can also export to Excel, PDF or

HTML files.

026-1022 R2 Connect+ Basic User Guide
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4. View Sites Not Sending Alarms

Sites that are grayed out are sites not sending alarms from Advisory Map. To determine the number of sites not sending alarms
and more information, you can click the Sites not Sending Alarms icon on Enterprise toolbar.

ul B

COPELAND 4

You will see a list of sites that are not sending alarms in the Connection Verification Report.

v View | Problem Sites v

Control System Test Connections Per Day Number Of Missed Connections
Site Supv 2
Kweb EVO

Xweb EVO

Demo 55 1
S5 and E2 24
Kweb EVO

S5 Pasr 1
D

HwehEVD

Kweb EVO

XWES EVO Fiera

e e e

Controls 2
)

Xweb500 1
Xweb EVO 1

Connection Verification Report
Time Perspective: | Site Time
(ResetFilters {3 Refresh Connections
Directory Site
Demo 152 Lab
L 1003
L 1006
Asia Demo Demo Site Supervi...
Demo 245 NVC
L 1001
Demo 250 wzke Forrest
D D
Demo Chillvenza
Demo EVO Dev
Demo Chillventa
Asia Demo Contrals 2
s D
Demo 54 Charlotte
Demo HwebEVO
4 4 | paget

FARNCIE

Show |25 ¥

Last Received Time = Next Recaived Time Commissioned Time

2/18/20 1:57 PM
6/12/19 2:52 PM
6/12/19 2:52 PM
5/8/19 3:29 PM

1/21/19 10:11 PM
12/6/18 B:51 AM

4/25/20 5:12 AM 10/23/19 4:52 PM
4/9/19 6:12 PM
5/17/18 1:14 PM
4/8/19 10:55 AM
11/7/18 3:02 PM
5/2/18 4:35 PM
6/15/18 9:40 AM
9/18/19 9:43 AM
11/29/18 3:46 AM
9/4/19 5:01 PM

4/25/20 11:02 AM
4(24/20 B:07 PM

7/2/18 7:37 AM 4(24/20 9:07 PM

3/3/20 7:03 AM
4/2/1% 1:24 PM
1/29/20 10:53 AM
10/18/19 2:20 AM
10/4/19 4:56 PM

Displaying inbound connections 1 - 15 of 15

Field Name Description

Test Connections
per Day

Number of Missed
Connections

Last Received Time

Next Received Time

Commissioned Date

Displays the number of connection tests
that occurred for the controller in 24
hours.

Displays the number of connection tests
missed for the controller in 24 hours.

Displays the date and time when the
latest connection test or alarm was
received.

Displays the date and time when the
next test connection will occur.

Displays the date and time when you
configured to send an advisory config-
uration such as connection test time
and advisory filter priorities for alarms,
failures, and notices for E2 and Site
Supervisor. And displays the first refresh
unit date time as commissioned Date for
XWEB and Danfoss.

026-1022 R2 Connect+ Basic User Guide 14

Connect
onnection Verification Repq

Deme
Most recent 3
Connacon Time

sddionsl 1o
CrReset iters G Refresh Connections
21820 157w

Direcory st Concrol 5ysf

2718720 1058 2
218720 514 A
2177205140

217720 814 2

16720518 M

oem

As with Advisory View, you can sort, filter, and add more
columns for your review. You can also export to Excel, PDF
or HTML files.

©2024 Copeland LP.



5. Monitor Site from Graphical Screens

5.1 Graphical Screen

Graphical Screens are floor plans or summary screens for

. 2 ) = [ Demo
real-time store monitoring. You can access these Graphical
Screens from the Navigation Tree, when you right-click on + . oo2ii
any level, you will see a list of System Screens indicated .
with a blue icon, and Customized Screens indicated with an Tﬁm Djtlg' Aizn
orange icon. anta
- System Screens are provided by Connect+ with EA Refrigeration Summary
predefined summaries at Site, Controller, Application 5 ] Building Summary

Type, and Application level. ry Other Summary

« Customized Screens can be developed by your Admin s Demo Refrigeration Summary

or Copeland to facilitate your customized needs to _
monitor or compare store performance. % EZ Store Summary

Y Summary

5.2 What You Can Do with Graphical Screens

You can right click on Point Value and Override a Point, you can also Display Log Graph, Real Time Graph, and View
Advisories for the Point. Note you can only use the right-click menu in a Point value field.

Refrigeration Summary

Mo application instamces of this Lype

: RAK LTTC RACK LT 7.

i7.0 15.0 PSI NONE - 4 100.0 % oK
: RAK LTyTC RACK TC 20.0 PSI 15.0 PsI NONERE SUCT MON TEMP i 100.0 % OK
: PROTO A/B PROTOCOL A 54.0 P51 50.0 PSI NONER 5 & 100.0 % OK
: PROTO A/B PROTOCOL B £3.0 PSI 54.0 PSI Lelils = Owverride & 50.0 % oK
Display Log Graph
Graph Cellection 3
Show en Real-time Graph
RX-300 4: EZ Unit0d COMDENSER ¥ Fan(s} On
RX-400 2: RAK LT/TC COMDENSER LT Point Properties 7 Fan(s} On
RX-400 2: RAK LT/TC COMDENSER TC ¥ Fanis} On
RX-400 3: PROTO A/B COMDENSER A Connection Verification Report 7 Fan{s} O
RX-400 3: PROTO A/B COMDENSER B ¥ Fan{s} O
Forward Advisories
View Adviseries
Create Setpoint Broadoast
Configure Advisory Snooze -
Mo application instances of this type ontigure AGVISOry onodze . REFRIGERATION -%.3 9F -13.0 OF
. T REFRIGERATION -1.4 9F 0.0 oF
Configure CB Maintanance o REFRIGERATION 0.0 °F 0.0 oF
Configure Log Purge D REFRIGERATION -2.2 9F 0.0 oF
g8 a5 REFRIGERATIOM -1.7 9F 0.0 oF
Edit Application Instance MT - REFRIGERATION 1.0 °F 0.0 °F
T == REFRIGERATION -0.5 9F 0.0 oF
RX-ADD 2: RAK LT/TC LTBA DT MEAT a5 REFRIGERATIOM -1.6 9F -1.0 9F
R¥-400 Z: RAK LT/TC LTEB DT MEAT == REFRIGERATION 0.1 °F 0.0 oF
RX-AD0 2: RAK LT/TC LTEC DT MEAT a5 REFRIGERATIOM 25.0 °F 28.0 °F
R¥-4DD0 X: RAK LT/TC LTS SEAFD FRZR s REFRIGERATION -7.5 9F 0.0 oF -
RX-400 2: RAK LT/TC MEAT PREP 30 a5 REFRIGERATION 42.7 °F 50.0 °F

Y [
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While you can View Point Log Graph from Advisory View,

Sho "
Advisory Email, Watch Point and Graphical Screens, you e = e
can only View Point Real Time Graph from Graphical )
Screens.
Real Time Graph allows you to watch the Point value
change in real time for different time intervals from 5
mlnutes Up to L\\J i B 154 Atianta/LT1 GROC/CONTROL TEMP
1 hour. You can also add more points from the Graphical ) o Dm4 P

Screen to Real Time Graph by right-clicking on the point "
value. The point path will be shown on the real time graph. '

5.3 System Summary Screen

Tree Level Name

Refrigeration Summary

Building Summary

Other Summary

Controller Summary

Summary

App Type

Defrost Summary

Status

Graphical Summary

How to Read Summary Screens

- 154 Atlanta/LT4 RI FROZ FD/CONTROL
T W

Shaw full path point lise

Description
Includes critical points from Suction Group, Condenser, and Case Controllers.

Includes critical points from Outside/Inside Temp and Humidity, AHU Temp &
Status, Lighting Status, and Schedules.

Includes critical points from Anti-Sweat, Demand Control, Power Channel, Analog
Sensor, and Digital Sensor.
Sites usually has multiple controllers:

- Building Controller Summary is a subset of Site Building Summary for that
specific controller.

- Ref Controller Summary is a subset of Site REF Summary for that specific
controller.

Includes critical points for below Application Types:

Circuits and other Case Controllers, Condenser, Suction Group, Physical Al/DI/DO,
Sensor Control AV/DV, HVAC Zone, Lighting Control, Power Monitoring,
Anti-Sweat, Analog Combiner, Digital Combiner, Flexible Combiner, and more.

Only applies to Case Controller Application Types

Includes critical input, setpoint and output points properties for Application In-
stance. Only an App Instance from an Application Type that has Summary Screen
will have a Status Screen. (See App Type > Summary)

Can be found in Application Instances from AHU, Condenser, Circuits, Suction
Group, Sensor AV/DV for graphical presentation of the physical device.

Summaries comprise several tables. The table header is defined as:

“Controller Name” “App. Instance Name” Point Value Point Value Point Value

026-1022 R2 Connect+ Basic User Guide
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In the below example, each table header has Unit as fixed header, with different Application Type such as Enhanced Suct
Grp, Condenser, Circuit (CC) and Circuit (Standard). For each Application Type, point is also different.

ALARMING!
Jn Enhanced Suct G Such T | e —— Active Stages Total Stages O Cap Sta
RX-400 2: RAK LT/1C RALCRA LT 17.0 PS5l 15.0 P51 oF m 51 4 1 100.0% OK
RX-400 2: RAK LT/TC RACK TC 200PS1  15.0 PSI -ﬁcr s 2 2 1000 % OK
RX-400 3: PROTO A/B PROTOCOL A 54.0PSI  50.0PSI °F 1500 Hsl 6 6 100.0% OK
RX-400 3: PROTO A/B PROTOCOLB 52.3PS1  54.0 PSI oF NONEL S 6 B33%  OK
Controller Name/App. Ins. Name Point Value
| Unit Condenser ; TSetpt TCtl VSRPM VS99  State
RX-300 4: E2 Unitd4 CONDENSER £ 77 77 K 77 Fan(s) on
AN-400 2: RAK LT/TC CONDENSER LT 198 ) 73 22 ?? Fan(s) On
RX-400 2: RAK LT/TC CONDENSER TC 182.3PS1 1B0.OPSI 77 77 77 7?2 Fan(s) On
RY-400 3: FROTO A/B CONDENSER A 77 72 97.0 oF EA59F 77 ?? Fan(s) OIT
R¥-400 3: PROTO /B CONDENSER B 150.0 PSI 222.0 PSI ?? 77 re T Fan({s) O
Summary Table Header Unit/Application Type Name
nit rcu CC) arm Ctate Temp Cetp I Uit ircu Stanc 77,"I arm ate if'fi:';l -~
No application instances of this type T PR o e s . REFRIGERATION -9.3 °F -12.0 °F
RX-400 2: RAX LT/TC LT2 RI FROZ FD . REFRIGERATION 0.7 ©F 0.0 oF
RX-400 2: RAK LT/TC LT3 RI FROZ FD REFRIGERATION -0.4 F 0.0 oF
RX-400 2: RAK LT/TC LT4 RI FROZ FD - REFRIGERATION 0.7 ©F 0.0 °F
RX-400 2: RAK LT/TC LTS RI FROZ FD . REFRIGERATION -2.0 F 0.0 °F
RAX-400 2: RAX LT/TC LT6 MD FROZ MT ._ REFRIGERATION -1.6 oF 0.0 °F
RX-400 2: RAK LT/TC LT7 RI FROZ FD . REFRIGERATION 1.7 °F 0.0 °F
RX-400 2: RAK LT/TC LTBA DT MEAT " REFRIGERATION 0.4 °F -1.0 oF
RX-400 2: RAK LT/TC LTSB DT MEAT . REFRIGERATION -1,2 8F 0.0 oF
RX-400 2: RAK LT/TC LTBC DT MEAT : REFRIGERATION 28.6 ©F 28.0 °F
RX-400 2: RAK LT/TC LTS SEAFD FRZR - REFRIGERATION -7.5 F 0.0 OF
RX-400 2: RAK LT/TC MEAT PREP 30 : REFRIGERATION 46.6 °F 50.0 oF

5.4 View Customized Screens

Your organization Administrator, Service Provider, or
Copeland Project Team might have developed Customized
Screens for you. Connect+ Graphical Screen Tools
provides different widget to allow library images and visual
presentations of your store to be created.

You can view store floor plans as shown below or pull data
from several stores to compare Food Safety Setpoints.
Consult your Administrator, Service Provider, or Copeland
Project Team about your needs. You can set a Customized
Screen as a Homepage or Site Homepage for quicker
access.
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6.1 Watch Points

COPELAND

) Ref

— @ Demo
+ iy 00211
= #0219 Xi=n
ER
4 i 100 Kennesaw
+ 152 Lab
= 4y 154 Atlanta
IfLE
3 B BX-400 1: HVAC/LTS
= | RX-400 2: RAK LT/TC
# [3 Alarm/Advisory Setup

th | Active Points

4 [4 Anti-sweats
3 [3 Circuits (Standard)
0L
2 @ Inputs
[/]| -~ case TemP 1
[| case TEMP STPT
[]  EMERGENCY OVR
[ LeAD cRourT
[[]  PRIDEMAND SHED
[ SEC DEMAND SHEL
[] STaRT DEFROST
# (8 Outputs
# B Params
H % Virtual

00

-
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= [l Demo
+ 4y 00211
+ i 0213 Xizn
e
+ i 100 Kennesaw
+ 152 Lab
= 4 154 Atlanta
IS E2
+ B BX-400 1: HVAC/LTS
= B RX-400 2: RAK LT/TC
4 [3 Alarm/Advisory Setup

h | Active Points

# [J Anti-sweats
= [3 Circuits (Standard)
0L
= @ Inputs
[¥]|~ case TEMP 1
[/]| - case TEMP STPT
[ EMERGENCY OVR
[ Leap crrocurm
[ PRIDEMAND SHED
[ SEC DEMAND SHEL
[ STaRT DEFROST
# (@ Outputs
# B Params
& {a} Virtual

o0

-
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6. Watch and Graph Points

Watch Points: It allows the user to view the real time value of the points.

When you click on the Watch Point Icon, you will be directed to Watch or Graph
Points page.

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list |...select list... v

Notes:
Disabled point names indicate points which only have logs and cannot retrisve real time values.

List Povrer Builder

You can select Points to watch or Graphs using the checkboxes in the tree or load
Points from a list.

Select Points to Watch from the Tree

Load Points from a List

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list | ...zelect list... v

AHU List
Amazon REF Points

Notes:

Disabled point names indicate points which anly have logs and cannet retrieve real time values.

List Power Builder
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Now you have many points in your review area. Click Watch Points at the bottom right corner.

|#| 75. BX2/Air Handlers {AHUs)/ MORTH DEH/'Outputs/SPACE TEMP OUT
|#] 76. BX2/Air Handlers (AHUs)/ SALES/Outputs/SPACE TEMP OUT

|#| 77. BX2/Air Handlers (AHUs)/ STOCKROOM/OQutputs/SPACE TEMP OUT
|| 78. BX2/Air Handlers (AHUs)/ BREAKROOM,/Qutputs/SPACE TEMP OUT

Load Selection from list | AHU List A

Watch Points

Wait several seconds for Connect+ to establish the real time communication to your controllers. You will see the value changes

from “?" to meaningful values.

|5 Circutts (Stndare]

=0
S @ Inputs Watch Or Graph Points

Site Directories / Watch Or Graph Peints

3 Oroze e L —
= B) Inputs.
|~ casETEMP 1 Motes:
¥ caseTEmp sTET Disabled point names indicate points which only have logs and cannet retrieve real time values.
[ EMERGENCY OVR
List Power Builder
[0 Leap creurm
r PRI DEMAND SHED

[/]| .~ casE TEMR 1
Bomrme: ey ey [ TT—— ve———

& [ Params
& By (] Sovoosnowist  [[EENUSES

[]  LEaD cIRCUIT ] 1. HVAC/LTS"/&ir Handlers (AHU=)/1-MAIN AHU/Inputs/COOL PROOF1 [ of
[ PRIDEMAND SHED [#l 2. RAK LT/TC"/Circuits {Standard)/Inpurs/CASE TEMP 1 EEG
[  SEC DEMAND SHEL ¥/ 3. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP STPT -12.09F
[[]  START DEFROST [#) 4. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP 1
# (3 Outputs [#) 5. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP STPT 0.00F

Stop Watching

6.2 What Else You Can Do With Points

In the Watch or Graph Points page, in addition to a watch points’ real value, you can also:

- Display Log Graph, Retrieve Logs, and Export for multiple points selected.

- Right-click on each point to access the Display Point Graph, Real Time Graph, and View Advisories.

Watch Or Graph Points

I#| 1. HVACSRir Handlers (AHUs)/IT STORAGE/Outputs/SPACE TEMP OL'g

SPACE TEMP OUT
|#] 2. HVAC/Air Handlers (AHUs)/RECEPTION AREA/Qutputs/SPACE TEY

arride
I# 3. HVAC/Air Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

|#| 4, HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TE!
|# 5. PALO CX=1/Air Handlers (AHUs)/AHU1 MzinSales/Outputs/SPACI
|# 5. PALO CX=1/Air Handlers (AHUs)/RTU1 Front End/Outputs/SPACE
|#| 7. PALO CX=1/Air Handlers (AHUs)/"RTU2 OfficeA/C"/Outputs/SPAC
|#| 8 HULarge/&ir Handler_001/0utputs/SPACE TEMP OUT

I# 9, HVAC/LTS"/Air Handlers (AHUs)/1-MAIN AHU/Outputs/SPACE

[« 10 HVAC/LTS"/Air Handlers [AHUs)/GMI-SALES AREA/Outputs,

l# 11 HVAC/LTS"/Air Handlers [AHUS)/RTU-1 BAKERY,/Outputs,

[« 12 HVAC/LTS"/Air Handlers (AHUs)/RTU-2A PRODUCE Qutputs

|¥| 12 HVAC/LTS"/Air Handlers (AHUs)/RTU-2B PRODUCE/Qutputs,

Show on Real-time Graph
Point Propartizs

Connection Verification Report
Forward Advisories

Vigw Advizories

Create Setpoint Broadcast
Configure Advisory Snooze
Configure CB Maintenance
Configure Log Purge

Edit Application Instance
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6.2.1 Display Log Graph
We have introduced how to read log graphs in the Advisory View session. You can also Display Log Graphs from Watch Points.

To view an alarming point’s log graph, right-click on the point name and select Display Log Graph. The Log Graph you
displayed is the same as the one you shown in the Advisory View.

To view multiple points log graph, click Display Log Graph and all selected points’ log graph will be shown for the same
time period.

Range 1H gELE 12H 1D 2D 4D 1w 4w
Site Time RALE Cj B E =
On
FS
o
z ff
= o L BB B S e e S . o e i S o S S S S o B n S o S Sn . S . Sn e L o B n Sn n S b o b Sn S S S e n S b S on S e Sn o S b S o n S S o S b e o S S n o S a o e o on o o
15:00 15:30 20:00 20:30 21:00 21:30 22:00 2Z2:30
-a- @ 134 Atlantz/1-MAIN AHU/COOL PROCFL
Highcharts.com
5
+
o
™ -5
o [ 1)
-13
15:00 15:30 20:00 20:30 21:00 21:30 22:00 22:30
—a= T 154 Atlant=/CASE TEMP L i 154 Atlants/ FO/CASE TEMP 1
~=- [ 154 Atlanta/CASE TEMP STET =~ @ 134 Atlantz/ FD/CASE TEMP STPT (no log in controller)
Higheharts.cor

6.2.2 Retrieve Logs

If the points you selected do not have logs retrieved, you might want to click the Retrieve Logs + Graph button or from the
graph click the menu and the click the Refresh icon (shown as two arrows in a circle). When you Retrieve Logs, Connect+ will

display the Activity progress.

Retrieve Logs From List
In Progress 62%

Target : Directory Multiple

Started 4/25/20 10:533 PM
Duration 2 s=conds
StartMethod On Demand

User

Hide Details

(Calculating Execution Data...
Processing 3 points...

Done processing points,
Starting on Directory Demo
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Once completed, you can go to E Header Menu > Activities > View My Activity History to check the Retrieve Logs status.

My Activity History - Results

Ocourrence Date |Past 7 Days v Show([25 ¥

@ Retrieve Logs From List 4/25/20 B:25FM 00:00:03 Multiple s Completed

@ Retrieve Logs From List 4/25/20 B:24 PM 00:00:02 Multiple 4 Completsd

6.2.3 Export

To export log data for these points, click Export and enter the time range. Click Go to start the export. Once completed, an
excel file will download to your computer.

Display Log Graph Retrieve Logs + Graph Retrieve Logs Retrieve Logs + Export m

From [2020-04-24 00:00:00 | [ To[2020-04-26 23:59:59 |[@ Time Perspective: File Type: [Comprehensive ¥ |
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7. Global Search

A search can be performed by entering criteria into the
search field on the Connect+ header. You can search for
a Site’s Home Screen, or for a specific Directory, Sites,
Controller, Devices or Points.

T
mewe  fw  UTAim

Icon Key

3¢ = oo [ O, O

®  voma remgeraton
@ oo
@ wm

When a site is configured with a Site Home Screen, you can
search the Home Screen by entering the site name.

To go directly to a Site’'s Home screen, click in the search bar
and select the Site Home Screen Name from the drop-down
menu.

If you click the search button, it will perform a normal search and returns all related results.

Search Resules Relevance I (0.0 0%

MNams Type iContext

Condensers Application Type = Demo > 162 = E2 = RX-400 4: LT DESK > Condensers
Condensers Application Type > A _Kennesaw TechSupport > 55 > E2 = RE-400 2: E2 Unit2 > Condensars
Condenzers Application Type > H > 00238 = E2 » RX-300 1: RACK A > Condensars
Condenzers Application Type = H > 00238 > E2 = R¥-200 2: RACK B > Condensers
Condensers Application Type = H > 00238 > E2 > R¥-300 3: RACK C > Condensars
Condenzers Application Type = Demo > 154 Atlanta = E2 > R¥-400 3: PROTD A/B > Condensers
Condensers Application Type = Demo > 134 Atlanta = E2 > R¥-400 2: RAK LT/TC > Condensers
Condenzers Application Type > M > MO0296 = E2 > R¥-400 2: RACK 1 = Condensers
Condenszers Application Type = M > M00256 = E2 > RX-400 3: RACK 2 > Condensers
Condensers Application Type > M > MO0296 = E2 > RX-400 4: RACK 3 = Condensers
Condenzers Application Type > M > MOO2%E > E2 > R¥-400 5: RACK 4 > Condensers
Condenzers Application Type =M = MO02%6 = E2 = R¥-400 6: RACK 5 > Condensers
Condensers Application Type > M » MOO2%E > E2 > R¥-400 7: UNIT § > Condensers
Condenzers Application Type = M = MO0120 = E2 > RX-400 1: RACK 182 = Condsnsers
Condensers Application Type > M = M00120 = E2 = RX-400 2: RACK 284 > Condenzers
Condznsers Application Type =M > MO0120 > E2 > RX-400 3: RACK 5 = Condensers
Condensers Application Type = R¥400-Refrig:LT DESK * Condensers

Condensers Application Type > Test > Fan Test » RX-400 2: RAK LT/TC > Condensers
Condenzers Application Type > Test > Fan Test > RX-400 3: PROTO A/B = Condensers
Condenzers Application Type = Test = Fan Test > R¥-300 4: E2 UnitD4 = Condensers
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8. View Enterprise Summary

The View Enterprise Summary located in the Toolbar Menu displays the overall understanding of your Enterprise Assets

such as:

- How many stores do | have?

- How many controllers do | have?
- How many are building controllers?

- How many are Ref Controllers?

- How many are E2 and how many are Site Supervisor?

- How many Case Controllers do | have?

+  How many Roof Top Units do | have?

COPELAND 4 2

15

*R B =

nJ

You can view Enterprise Summary from Directory to Application Instance. Each contains different information.

Enterprise Summary
@ F F @
Centrol System » Model a2nd Series -
. 4| sort Ascending ALL —
XWES name Demo HwehEVD V.STANDARD 7 Z] SortDescending Unknown 4
TEST Demo 54 Charlotte Kweb500 2.2.1_065 Ver:2.0.0 Unknown 4
Xweb5000EVO Demo XWEB EVO Fiera V.STANDARD 12 Columns P | @ Unic
Jenny9 Demo EVO Dev Hineb EVO V.STANDARD 10 br2014.08 [#] Directory
Jenny9 Demo HwebEVD b EVO V.STANDARD 10 br-2014.08 @ see
US_1001_L Bon A L 1001 Hweh EVO vii br-2014.08
[#] Contraol System
US_1003_L_Newport.. L 1003 Xuwieb EVO w11 br-2014.08
US_1006_L_Suffolk_. L 1006 Xweb EVO Vi1 br-2014.08 La| e GRS
Lebss 152 Bzhama Site Test [=3 214807 [ Coneraller Version
E2 Unit02 Demo 100 Kennesaw TechSupport RX-400 <.08F04 [¥] Gateway
55 Unit01 Supervisor New Site sup RXe 2.07F01 Menitoring Master
SUITE 170 Demo 100 Kennesaw Suite 100 BX-300 <.10F01
[[] Annundator
HVAC Demo 100 Kennesaw Suite 100 BX-400 4.09883
Rack A Dems 250 Wake Forrest S Peer cxe 2.12836 o] el B G
7 [@] Mumber of Backups Implemented
) Lo Bacup Time

MEooowWwooooooooo

o2 ¥

03/19/20 07:46 AM

05/11/18 10:23 PM -
3

As with Advisory View, you can sort, filter, and add more columns for your review. You can also export to Excel, PDF, or HTML

files.

026-1022 R2 Connect+ Basic User Guide

23

©2024 Copeland LP.



Appendix A: Summary of Export Capability

Advisories Advisory View
Live Advisories Live Advisory

Watch Points

Log Data

Log Graph
Connection Verification Report Site not Sending Alarms
Enterprise Summary Enterprise Summary

Appendix B: System Summary Screens

Toolbar Menu & Tree
Control System

Watch Point Page

Advisories View > Log Graph > Setting
Watch Points > Log Graph > Setting
Graphical Screens > Log Graph > Setting

Toolbar Menu

Toolbar Menu

System Summary Screen Ul Access Level

Refrigerant Summary Site

Building Summary Site

Other Summary Site

Summary (Controller) Unit

Summary (Application) Application Type
Defrost Summary Application Type
Graphical Status Application Instance
Status Application Instance
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Site Level: Refrigeration Summary

Refrigeration Summary

v
No application instances of this type

Total Stages

RX-400 2: RAK LT/TC RACK LT 17.0 PSI 15.0 PSI e 4 oK
RG-A00 2: RAK LT/TC RACK TC 20.0 PST 15.0 PSI SUCT MON TEMP 2 100.0 % OK
RX-40@ 3: PROTO A/B PROTOCOL A 54.0 P51 50.0 PSI & 100.0 % OK
RX-A00 3: PROTO A/B FROTOCOL B 63.6 PSI 54.0 PSI 6 50.0 % oK

Display Log Graph
Graph Collection b

Condenser P Ctrl P Sel

Show en Real-time Graph

RX-300 4: E2 Unitdd CONDENSER NOWE PSI  200.0 FS| iR Fanis} On
RX-400 2: RAK LT/TC COMDENSER LT 2162751 210.0 75 Point Propertiss 72 Fanis} On
RX-400 2: RAK LTYTC CONDENSER TC 1724751 180.0 FS! 7 Fanis} On
RX-400 3: PROTO A/ COMDENSER A 72 72 Connection Verificstion Report 72 Fanis) QI
RX-400 3: PROTO A/B COMDENSER B 150.0 P51 222.0 PS| 22 Fani{s} OIT
Forward Advisories
View Advisories
Create Setpoint Broadcast
U Circuit (CC Alarm State . landard)Alarm  State  Temp Seipt i
Mo application instances of this bype Caonfigure Advisory Snooze - REFRIGERATION -3.3 °F -12.0 °F
) D - REFRIGERATION -1.4 9F 0.0 oF
Configure C8 Maimenance D - REFRIGERATION 0.0 8F 0.0 oF
Configure Log Purge D - REFRIGERATION -2.2 9F 0.0 oF
D - REFRIGERATION -1.7 9F 0.0 oF
Edit Application Instance MT - REFRIGERATION 1.0 °F 0.0 oF
D - REFRIGERATION -0.5 9F 0.0 oF
RX¥-400 2: RAK LT/TC LTBA DT MEAT - REFRIGERATION -1,6 9F -1.0 oF
R¥-400 2: RAK LT/TC LTBB DT MEAT - REFRIGERATION 0.1 °F 0.0 oF
R¥-4D0 2: RAK LT/TC LTBC DT MEAT - REFRIGERATION 25.0 °F 28.0 °F
R¥-400 2: RAK LT/TC LT3 SEAFD FRZR - REFRIGERATION -7.5 9F 0.0 oF
RX-AD0 2: RAK LT/TC MEAT PREF 30 - REFRIGERATION 42.7 8F50.0 6F

Site Level: Building Summary

/Demo/154 Atlanta

Building Summary

RX-400 2: RAK LT/TC °F RH NOME RH Fic
RX-400 3: PROTO A/B L7 RH NOMNE RH Fte
Unit AHU Temp Setp Status Occupied
BX-400 1: HYAC/LTS 1-MAIN AHU NOME =F NONE °F Mo Ctrl UNROCC
AHUL NOME &F HONE °F No Ctrl UROCC
GMI-SALES AREA NOME ©F NONE °F Mo Cirl UNOCC
RTU-1 BAKERY NOME °F NOMNE °F Mo Ctrl UNOCC
RTU-24 PRODUCE NOME ©F NONE °F Mo Cirl UNOCC
RTU-2B PRODUCE NOME °F NONE °F Mo Ctrl UNOCC
RTU-3 KITCHEN NOME ©F NONE °F Mo Ctrl UNOCC
BX-400 1: HVAC/LTS RTU-4 CONF RM NOME =F NONE °F Mo Ctrl UROCC
Unik ARTC L ghting Outp Unit Schedule Dutp
No application instances of this type EX-400 1: HVAC/LTS OUTSIDE LIGHTS on BEX-400 1: HVAC/LTS 10101 na
BX-400 1: HVAC/LTS PARKING LOT an BX-400 1: HVAC/ILTS MAIN OCCUPARNCY arr
BX-400 1: HVAC/LTS SALES LIGHTS On BX-400 1: HVAC/LTS RTU-1 QOUPANCY na
BX-400 1: HVAC/LTS STOCK LIGHTS arr BX-400 1: HVAC/LTS RTU-24 OCUPNCY on
BX-400 1: HVAC/LTS RTU-2E OCUPNCY on
BX-400 1: HVAC/LTS RTU-3 OOUPANCY on
BX-400 1: HVAC/LTS RTU-4 OCUPANCY on

m Refrigeration Summary | Other Summary
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Site Level: Other Summary

Other Summary

Unik Anti-Sweat nt
R¥-400 2: RAK LT/TC ANTI-SWEATO1 HNOME °F 0.0
RX-400 2: RAK LT/TC ANTI-SWEATD2 NONE °oF 0.0
R¥-400 2: RAK LT/TC ANTI-SWEATOZ HNOME °F 0.0

niro : 3 Unit Power Channel KW Avg KW Shed Time in Shed

Dremand i
Ne apglication instances of this type EX-400 1: AT POWER MON 0.0 KWO.0 KW RESTORED

HVAC/LTS
Unit Analog Sensor Value Command N Unit Digital Sensor Cirl Value Command N
BX-400 1: HVAC/LTS COMPRESOR ROOM HOME &F ar EX-400 1: HVAC/LTS Load arr ar
BX-400 1: COMPUTER ROOM NONE oF oarr . H 12VDC PWR RX#2 or m
BEX-400 PHARMALCY TEMP HOME &F ar ALARM DISABLE na arr
RX-400 2: RAK LT/TC AMB TMP SEL LT NONE oF oarr AX-400 2: RAK LT/TC ATC BYPASS LT o o
R¥-400 2: RAK LT/TC AME TMP SELTC 50.0 °F ar A¥-400 2: RAK LT/TC ATC BYPASS TC arr arr
RX-400 AMB TMPCALC LT S0.0 °F oarr ANM-400 2: ATC CONTROL LT o on
RX-400 AME TMPCALZ TC HOME &F ar AX-400 ATC CONTROL TC arr on
RX-400 2: RAK LT/TC DIS TEMP RK LT NONE oF oarr AX-400 2: RAK LT/TC MTPREP RUN PRF or m
R¥-400 2: RAK LT/TC DIS TEMP RK TC HOME &F ar A¥-400 3: PROTO A/B ALARM DISABLE na arr
RX-400 2: RAK LT/TC DISCH TEMP LT NONE oF on h AX-400 3: PROTO A/B ATC CONTROL A or on h
m m Refrigeration Summary Building Summary
H .
Controller Unit Level: Controller Summary
-
Building Controller Summary
Controller Summary
AHU Temp Setp Status Occupied
1-MAIN AHU NONE °F NONE Mo Curl UNOCC
AHUL NONE °F NONE No Curl UNOCC
AREA NONE °F NONE Mo Curl UNOCC
RTU-1 BAKERY NONE °F NONE Mo Curl UNOCC
RTU-2A PRODUCE NONE °F NONE Mo Curl UNOCC
RTU-2B PRODUCE NONE °F NONE Mo Curl UNOCC
RTU-3 KITCHEN NONE °F NONE Mo Curl UNOCC
RTU-4 CONF BRM NONE °F NONE Mo Curl UNOCC
ARTC Temp Occup ghting tp Schedule Duiput
No application instances of this type OUTSIDE LIGHTS On 10101 na
PARKING LOT Oon MAIN OCCUPANCY ofr
SALES LIGHTS On RTU-1 OCUPANCY na
STOCK LIGHTS arr RTU-2A OCUPNCY Oon
RTU-28 OCUPNCY Oon
RTU-3 OCUPANCY Oon
RTU-4 OCUPANCY Oon
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Ref Controller Summary

Controller Summary
Suct SP
Ho application instances of this bype
T .
RACK LT 17.0 PSI 15.0 PSI 4 4 100.0 %  OK
RACK TC 20.0 PSI 15.0 PSI 2 2 100.0%  OK
Condenser P Ctrl P Sed T Cird T Setpt V5 RPM V5 State
CONDENSER LT 211.3 PSl 210.0 P51 77 7 77 7 Fanis) On
COMDENSER. TC 171.9 PSI 180.0 PSI EE] ER] EE] ER] Fan{s) On
Circuit (CC Alarm Siate Temp sitpt Circuit (Standard Alarm State Temp Setp ~
Ne application instances of this Lype GROC - REFRIGERATION 939  -12.00%F
FROZ FD - REFRIGERATION 03°F  0OCF
FROZ FD s REFRIGERATION 1.30F 0.0 oF
FROZ FD - REFRIGERATION 029  0.00F
FROZ FO - REFRIGERATION -149F  0.0°F
FROZ MT - REFRIGERATION 029 00O°F
FROZ FD s REFRIGERATION -0.39F 0.0 oF
OT MEAT - REFRIGERATION 0.7 OF  -1.09F
DT MEAT - REFRIGERATION -L.79F  0OoF
DT MEAT - REFRIGERATION 22.0°F 2R.0°0F
FRZR s REFRIGERATION -7.59F 0.0 oF
MEAT FREP 30 - REFRIGERATION sa.icoF saOcF T
. . .
Application Type Level: Summary Screens
Circuits (Standard)
Name State Temp Alarm Refr
GROC REFRIGERATION -8.3 °F s on o
RI FROZ FD REFRIGERATION -0.6 oF s off o
RI FROZ FD REFRIGERATION 1.4 oF s off o
RI FROZ FD REFRIGERATION -2.8 °F s o o
RI FROZ FD REFRIGERATION -0.9 °F s ofr o
MD FROZ MT REFRIGERATION 1.0 oF = off o
RI FROZ FD REFRIGERATION -1.8 oF s off o
MEAT REFRIGERATION -2.2 °F = o o
MEAT REFRIGERATION 1.7 °F s on o
MEAT REFRIGERATION 27.1 9F s off o
FRZR REFRIGERATION -7.5 O0F = On o
MEAT PREP 3D REFRIGERATION 47.0 9F s o o
SRVC FISH REFRIGERATION -3.5 °F - on o
RI [CREAM REFRIGERATION -5.30F as on ofr
RI [CREAM REFRIGERATION -1.7 oF as on ofr
RI FRZ FD REFRIGERATION -0.2 °F s on o
FRZ SEAFD REFRIGERATION -1.6 °F s on (51
Defrost Summary
Circuit  Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Defr Max
e 1 2 3 4 5 6 7 & © 10 11 12 13 14 15 16 17 ) 9 20 21 22 23 24 Time
cRoc 030 B30 w80 R 2772 s 0 0 0 0 : 0 0 0 0 : 0 0 0 0 o7 GAE 0035
gRiZ w00 ? 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
s FEEUTNE R S T D S S S T ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
oz 20 7 o o ot o 7 1 % ® ® ® ® ® ® ® ® ® ® ® ® ® ® HOT GAS 0:20
Egnz 2:30 6:00 14:30 20:30 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 HOT GAS 0:20
p=e 3:00 ®:00 1500 20007 0F 0?7 P 7 ® ® ® ® ® ® ® ® ® ® ® ® ® ® HOT GAS 0:20
Egnz 3:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
MERT PHETR IR T T T T S A : : : : : : : : : : : : : : HOT GAS D:20
MEAT T ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
MEAT ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:20
FSREQED 4:30 10:30 16:30 22:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:25
. OFF .
MEAT PREPIDZ:OO T 0?7 7 F P P % 7% ] ] ] ] ] ] ] ] ] ] : : : : e 200
SRVC
i FERETR I T T N I : : : : : : : : : : ] ] ] ] HOT GAS D:18
IkéREAM 5:30 17:30 7 ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? HOT GAS 0:22
RI
= (R T T N L : : : : : : : : : : ] ] ] ] HOT GAS D:22
:]sz 3:00 15:00 7 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T 7T HOT GAS 0:20
FRZ
I 1:00 7:00 13:00 19:00 7 + + + + + + + + + + + + + + + + + + + HOT GAS 0:18
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Application Instance Level: Status Screen & Graphical Status

Cantral Temp -8,3 OF
Case Temp Setpoint -12.0 oF
Term Type TIME

1 BN

Status: REFRIGERATION

Refrigeration on
Defrost Off
Fan On
LLS IMNACTW
Clean Switch MONE
/Demo/154 Atlanta/E2/"RX-400 2: RAK LT/TC"/Circuits (Standard)/LT1 GROC
Standard Circuits Status
EMERGEMNCY OVR na Term Type TIME CIRCUIT STATE REFRIGERATION
CASETEMP 1 oF CASE TEMP STPT -12.0 oF REFRIG SOLENOID on
CONTROL TEMP -9.3 oF CASE ALM HI SP 41.0 °F DEFROST Off
CASE ALM LO SP -15.0 oF PEAK DEF TEMP 56.2 °F
COMB ALM HI 5P NONE ©F FAN on
COMB ALM LO SP MNONE °F BYPASS STATE MNORMAL
ACTIVE SETPT -12.0 °F ALARM OUT o=
ALG STATUS

CASE ALMOUT 1

OK
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Visit our website at copeland.com/en-us/products/controls-monitoring-systems for the latest technical documentation and updates.
For Technical Support call 833-409-7505 or email ColdChain.TechnicalServices@Copeland.com

The contents of this publication are presented for informational purposes only and they are not to be construed as warranties or guarantees, express or
implied, regarding the products or services described herein or their use or applicability. Copeland reserves the right to modify the designs or specifications of
such products at any time without notice. Responsibility for proper selection, use and maintenance of any product remains solely with the purchaser and end-
user. ©2024 Copeland is a trademark of Copeland LP.
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